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EXECUTIVE SUMMARY 

Sacramento Orcutt grass (Orcuttia viscida) is an annual plant that is designated as endangered 

under the California Endangered Species Act and federal Endangered Species Act. Sacramento 

Orcutt grass is only found in vernal pools on remnant depositional stream terraces in eastern 

Sacramento County, and there is a population of Sacramento Orcutt grass at the approximately 

eight-acre California Department of Fish and Wildlife (CDFW) Phoenix Field Ecological Reserve 

(Reserve).  

Invasive waxy mannagrass (Glyceria declinata) is also present in vernal pools on the Reserve, 

and can compromise the integrity of vernal pools supporting Sacramento Orcutt grass. Efforts to 

control waxy mannagrass on the Reserve in the past have been largely successful, 

demonstrating that waxy mannagrass control is possible, but waxy mannagrass is no longer 

being controlled on the Reserve. If populations of waxy mannagrass on the Reserve are left 

unmanaged and expand, they will continue to threaten Sacramento Orcutt grass.  

Two monitoring macroplots (A and B) were established on the Reserve in 2014 to monitor the 

frequency of Sacramento Orcutt grass, waxy mannagrass, and other plant species, and as a 

reference for photomonitoring. Sacramento Orcutt grass has been regularly observed on the 

Reserve for several decades, and Sacramento Orcutt grass was present in both macroplots on 

the Reserve every year from 2014 to 2017. Based on these observations, the Sacramento 

Orcutt grass population at the Reserve appears to be relatively stable at this time. Between 

2014 and 2017, 2015 appears to have been the “best” year for Sacramento Orcutt grass, 2014 

appears to have been the “worst” year, and 2016 and 2017 were somewhere in between.  

A threshold for management action to control waxy managrass on the Reserve was set for a 

waxy mannagrass frequency (1m2) of ten percent or greater. Waxy mannagrass was not 

observed at all within Macroplot A, but waxy mannagrass was observed in Macroplot B, and the 

management threshold was exceeded by the frequency confidence interval in both 2015 and 

2017. As a result, a management action should be triggered in Macroplot B in 2018, and CDFW 

staff should cut and remove each waxy mannagrass plant above the root system, prior to seed 

development.  

Pilot data for this monitoring plan was collected in 2014, and the monitoring plan presented in 

this report was implemented from 2015 to 2017. Implementation of the monitoring plan 

presented in this report is expected to continue into 2021 or later. The monitoring plan 

presented in this document should continue to be implemented by CDFW staff to facilitate the 

adaptive management of Sacramento Orcutt grass at the Reserve.  

 



1 

California Department of Fish and Wildlife  Phoenix Field Ecological Reserve 
Sacramento Orcutt Grass Monitoring Plan 

PHOENIX FIELD ECOLOGICAL RESERVE  
SACRAMENTO ORCUTT GRASS 

MONITORING PLAN 
CALIFORNIA DEPARTMENT OF FISH AND WILDLIFE 

TABLE OF CONTENTS 

1. INTRODUCTION ................................................................................................................ 3 

1.1. Site Description ............................................................................................................ 6 

2. ECOLOGICAL MODEL ....................................................................................................... 6 

2.1. Life History of Sacramento Orcutt Grass ...................................................................... 6 

2.2. Life History of Waxy Mannagrass ................................................................................. 9 

3. MANAGEMENT OBJECTIVES ..........................................................................................10 

4. MONITORING DESIGN .....................................................................................................10 

4.1. Spring Frequency Monitoring ......................................................................................10 

 Sampling Objective ..............................................................................................14 

 Before Going into the Field ..................................................................................14 

 In the Field ...........................................................................................................16 

 Back in the Office .................................................................................................19 

4.2. Annual Photomonitoring for Adaptive Management ....................................................20 

 Before Going into the Field ..................................................................................20 

 In the Field ...........................................................................................................20 

 Back In the Office ................................................................................................21 

5. RESPONSIBLE PARTIES .................................................................................................22 

6. FUNDING ..........................................................................................................................22 

7. MANAGEMENT IMPLICATIONS OF POTENTIAL RESULTS ............................................22 

8. REFERENCES ..................................................................................................................23 

9. DATA SHEET EXAMPLES ................................................................................................24 

 

TABLES, FIGURES, AND APPENDICIES  

Figure 1: Regional Location of Phoenix Field Ecological Reserve .............................................. 4 

Figure 2: Approximate Locations of Rare Plants at Phoenix Field Ecological Reserve ............... 5 

Figure 3: Ecology of Sacramento Orcutt Grass (Orcuttia viscida) ............................................... 7 



2 

California Department of Fish and Wildlife  Phoenix Field Ecological Reserve 
Sacramento Orcutt Grass Monitoring Plan 

Figure 4: Ecology of Waxy Mannagrass (Glyceria declinata) ...................................................... 8 

Figure 5: Locations of Monitoring Macroplots at Phoenix Field Ecological Reserve ................. 11 

Figure 6: Macroplot A Frequency Quadrat Locations, 2017...................................................... 12 

Figure 7: Macroplot B Frequency Quadrat Locations, 2017...................................................... 13 

Figure 8: Equipment Checklist ................................................................................................. 15 

Figure 9: Nested Frequency Quadrats ..................................................................................... 19 

 

Table 1: Latitude and Longitude of Plot Monuments in Decimal Degrees ................................. 17 

 

Appendix 1: Phoenix Field Ecological Reserve Plant List 

Appendix 2: Orcuttia viscida Field Photo 

 

  



3 

California Department of Fish and Wildlife  Phoenix Field Ecological Reserve 
Sacramento Orcutt Grass Monitoring Plan 

1. INTRODUCTION  
Sacramento Orcutt grass (Orcuttia viscida) is an annual plant that is designated as endangered 
under the California Endangered Species Act and federal Endangered Species Act. Sacramento 
Orcutt grass is only found in vernal pools on remnant depositional stream terraces in eastern 
Sacramento County. A population of Sacramento Orcutt grass occurs within vernal pools at the 
approximately eight-acre California Department of Fish and Wildlife (CDFW) Phoenix Field 
Ecological Reserve (Reserve) (Figures 1 and 2).  

The Reserve was donated to CDFW in 1979 by the Sacramento Savings and Loan Association 
at the request of Westwood Homes, Inc., the developer of the adjoining Rollingwood 
development. The Reserve was established as mitigation for this nearby development and is 
currently managed by CDFW. CDFW manages the Reserve to conserve onsite vernal pools 
which support populations of the endangered Sacramento Orcutt grass and the rare pincushion 
navarretia (Navarretia myersii ssp. myersii) which has a California Rare Plant Rank of 1B.1. The 
Reserve is now surrounded on all sides by dense single-family residential housing. There is no 
public access to the Reserve, but trespass by neighboring residents appears to be frequent.  

A land management plan was prepared for the Reserve in 2006, but was not implemented (ESA 
2006). The 2006 land management plan includes important background information on the soils, 
hydrology, plants and animals of the Reserve, and includes several goals and tasks for 
management of the Reserve that remain valid. Despite the goals and tasks for management of 
the Reserve, management of the reserve has been limited to infrequent control of the vegetation 
that grows along the fences surrounding the Reserve, and the non-CDFW effort described in the 
following paragraph. One of the tasks identified in the 2006 management plant is: “survey all 
vernal pools and swales annually during the spring for the presence of mannagrass (Glyceria 
species) and eradicate all plants using mechanical means before they set viable seed”. 

The invasive waxy mannagrass (Glyceria declinata) is present in vernal pools on the Reserve, 
but the areas that support Sacramento Orcutt grass remain largely free of the weed. In 2007 
and in some of the subsequent years John Gerlach undertook efforts to weed waxy mannagrass 
from the pools on the Reserve that support Sacramento Orcutt grass. Mr. Gerlach cut each 
waxy mannagrass plant at the upper end of its root system and removed the upper portion of 
the plant, effectively killing it. These efforts appear to have eliminated or significantly reduced 
waxy mannagrass in Sacramento Orcutt grass pools on the Reserve.  

This Phoenix Field Ecological Reserve Sacramento Orcutt Grass Monitoring Plan (Monitoring 
Plan) should be implemented by CDFW staff at the Reserve. The purpose of the Monitoring 
Plan is to monitor the status of the Sacramento Orcutt grass population at the Reserve in order 
to identify and alleviate threats from competing species such as waxy mannagrass or other 
factors before they become prohibitively expensive to address. This Monitoring Plan provides 
background information on the monitoring approach used, detailed instructions on how to collect 
both qualitative and quantitative data on populations of Sacramento Orcutt grass, waxy 
mannagrass and other plant species, and management implications of potential results. The 
Monitoring Plan is intended to provide a foundation for management of Sacramento Orcutt 
grass at the Reserve, but it is not intended to be so rigid as to preclude adaptation and flexibility 
in the future. The monitoring consists of two parts: 

1. Spring nested frequency monitoring of plants within the two sections of vernal pools on 
the Reserve that contain Sacramento Orcutt grass; and 

2. Photomonitoring of the Reserve.  
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1.1. SITE DESCRIPTION 

The Reserve is generally open with annual and perennial vegetation that is generally low to the 
ground. The topography consists of interconnected seasonally-inundated vernal pools and 
swales with higher mima mounds in the upland areas. Vernal pools on the Reserve are near the 
top of the local watershed, and therefore receive their water from surface runoff in the 
immediate vicinity. The Reserve is impacted by the nearby residential housing and related 
offsite irrigation which has altered the hydrology of the vernal pools. Currently, surface and 
ground water drainage onto the Reserve from the north and east are intercepted by a drain 
system that runs along the entire northern and eastern boundaries. A drain system and weir 
have also been constructed along the western edge of the Reserve to convey runoff from 
residences into the storm water sewer system. As a result of these drainage systems and loss 
of habitat, approximately two acres of watershed that would have drained into the pools on the 
Reserve has been lost, resulting in an estimated five to eight week delay in the initial filling of 
the main vernal pool on the Reserve. Runoff from the irrigated horse pasture that is South of the 
Reserve has resulted in severe degradation of portions of vernal pools on the Reserve adjacent 
to the pasture.  

Vegetation on the mima mounds grows somewhat taller than elsewhere on the Reserve, and 
vegetation in the pools and swales grows somewhat shorter than elsewhere on the Reserve. 
Shrubs and trees are only present around the perimeter of the ecological reserve adjacent to 
fencing and neighboring houses. One large and several smaller Quercus douglasii trees occur 
in the southeast corner of the Reserve. Soils on the Reserve are primarily mapped as Red Bluff-
Redding complex gravelly loam (NRCS 2014).  

2. ECOLOGICAL MODEL 
See Figures 3 and 4 for ecological models of Sacramento Orcutt grass and waxy mannagrass 
(Glyceria declinata). 

2.1. LIFE HISTORY OF SACRAMENTO ORCUTT GRASS 

An overview of the life history of Sacramento Orcutt grass is presented in the 2005 U.S. Fish 
and Wildlife Service Recovery Plan for Vernal Pool Ecosystems of California and Southern 
Oregon. A brief synopsis of Sacramento Orcutt grass life history is presented below, with 
information from the 2005 Recovery Plan and other sources. 

Sacramento Orcutt grass is an annual plant of the grass family (Poaceae). Seeds of Orcuttia 
species germinate underwater in January and February (Griggs 1980, Griggs and Jain 1983, 
Keeley 1998), after being colonized by aquatic fungi (Griggs 1980, 1981). Cold treatment and 
other forms of stratification have promoted germination in some species of Orcuttia (Keeley 
1988, Griggs 1974, Stone et al. 1988) and may benefit Sacramento Orcutt grass as well. 
Sacramento Orcutt grass grows underwater for three months or more and has evolved specific 
adaptations for aquatic growth (Keeley 1998). Among these adaptations is the formation of 
three different leaf types: a well-developed rosette of juvenile leaves (Keeley 1998), floating-
leaves that form as water in the pool warms and remain as long as the standing water lasts 
(Hoover 1941; Griggs 1980, 1981; Reeder 1982; Keeley 1998), and typical terrestrial leaves that 
form as soon as pools dry, normally in June or July (Hoover 1941; Griggs 1980, 1981; Reeder 
1982; Keeley 1998).  

Inflorescences appear within a few days after the water evaporates, and Sacramento Orcutt 
grass flowers in May and June (S. Cochrane in litt. 1995, Reeder 2012). June and July are the  
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Senescence 

 Seed bank may be +50 times larger 
than vegetative population 

 Likely viable at least 3 to 4 years 

 Predation and diseases unknown 

 Flowers appear after water evaporates – May-June 

 June and July are peak flowering, but flowering may continue into September in 
wet years 

 Wind and bee pollination 

 Waxy mannagrass competes for light/space/water/air, may inhibit reproduction 

 Sets seed June-July 

 Average of 500 seeds per plant 

 Local dispersal by water when rain 
breaks spikelets and scatters seed   

 Seeds do not naturally disperse far (3 
meters max) but may have 
occasionally been transported by 
animals 

Reproductive 

Seedling 

 Grows underwater for 3 months or more  

 Waxy mannagrass competes for 
light/space/water/air and may alter 
nutrient cycles, inhibiting growth  

 Nutrients from pastures or homes may 
inhibit growth 

 Plants near center of pools typically 
grow larger and produce more spikelets 
than those near the margins   

 Germinates underwater in January-
February 

 Steady rain (over 40 cm) November 
through April triggers large populations 

 Cold treatment and other forms of 
stratification likely promote germination 

 Low populations in dry years 

 Waxy mannagrass shades out and 
eliminates bare ground  

 Nutrients from pasture or homes may 
inhibit germination 

Figure 3. Ecology of Sacramento 
Orcutt Grass (Orcuttia viscida) 

Seed Bank 
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 Seed bank longevity may not be particularly long 

 Seed may germinate after rains but before 
ponding 

 High soil and water fertility 
requirements, addition of 
nutrients from nearby 
pasture and houses may 
enhance population  

 Ongoing hand weeding 
prior to reproduction may 
reduce populations 

 Wind pollination  

 Spikelets mature from 
late April to May 

 Functions as an annual in the 
Central Valley. 

 Plants die in late spring/summer 

 Dead plants can cover bare ground 
 

Figure 4. Ecology of Waxy Mannagrass  
(Glyceria declinata) 

Seed Bank 

Senescence Reproductive 

 Grows from high water mark to 
bottoms of vernal pools 

 Dense invasions appear to 
eliminate or significantly reduce 
populations of all native annual 
plant species 

 Produces lots of fine root mass 
just under soil surface and large 
leaf mass probably affecting 
nutrient cycling and increasing 
transpiration (water loss).  

 Waxy mannagrass competes for 
light/space/water/air: inhibits 
growth of other species. 

 Seeds coat the ground below the plant in 
late April and May 

 Seeds stripped from culms of maturing 
plants by waterfowl and probably provide 
long distance dispersal 

 Seeds also dispersed by water 

 Humans and wildlife also disperse seed 
over shorter distances: seed sticks to wet 
pants, boots, fur?  
 

 Seed may germinate after rains 
but before ponding 
 

Seedling 
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peak months of flower production for most species of Orcuttia, although flowering may continue 
into August and September in years of above-normal precipitation (Griggs 1980, 1981). Late-
spring rains may prolong the flowering season (Griggs 1981, Griggs and Jain 1983), but 
inundation is more likely to kill flowering individuals (J. Silveira in litt. 1997). Based on the timing 
of flower development and estimates of genetic diversity, the genus Orcuttia is believed to 
outcross (Griggs 1980, Griggs and Jain 1983). Sacramento Orcutt grass is adapted for wind 
pollination, but also provides a source of pollen for native bees (Griggs 1974, Stone et al. 1988).  

Plants set seed in June and July (Holland 1987), and spikelets break apart and scatter their 
seeds when autumn rains arrive (Reeder 1965; Crampton 1976; Griggs 1980, 1981). Seeds 
likely do not disperse far under natural conditions. In a 6-year period, an experimental 
population spread at most 3 meters (10 feet) from the seed source, and 95 percent of plants 
were within 30 centimeters (11.8 inches) of the source (R. Holland in litt. 1986). A demographic 
study conducted from 1974 to 1978 (Griggs 1980, Griggs and Jain 1983) indicated that 
Sacramento Orcutt grass produced an average of 500 seeds per plant. At one site in 1978, 88 
percent of plants survived to maturity. The size of the seed bank stored in the soil was about 44 
times as great as the population of growing plants (Griggs 1980, Griggs and Jain 1983). Seed 
production in the Orcuttia genus can vary two- to three-fold among years (Griggs 1980, Griggs 
and Jain 1983).  

The number of Sacramento Orcutt grass plants varies with rainfall. Large numbers of plants 
grow only in years when seasonal rainfall exceeds 40 centimeters (15.7 inches), particularly 
when heavy rains begin in November and continue through the end of April (Holland 1987). 
Sacramento Orcutt grass is apparently less likely to germinate in years of below-normal 
precipitation than other members of the Orcuttieae tribe of grasses (Griggs 1980, Griggs and 
Jain 1983). Genetic diversity between populations of Sacramento Orcutt grass was low based 
on studies of enzyme systems; however, plants from the primary area of concentration had 
alleles that did not occur in other areas. The amount of genetic variation occurring among 
related individuals was about equal to that within populations (Griggs 1980, Griggs and Jain 
1983).  

2.2. LIFE HISTORY OF WAXY MANNAGRASS 

Waxy mannagrass is an invasive plant in the grass family (Poaceae) that is native to Europe. 
Waxy mannagrass is described as a perennial plant, but it functions as an annual plant in 
California. Waxy mannagrass seedlings have been observed to germinate after the first fall 
rains but before ponding, developing terrestrial leaves first, and later aquatic leaves after 
inundation of pools (Gerlach 2012).   

In the Central Valley of California, waxy mannagrass spikelets mature from late April through 
May. Seeds are dispersed by floating on the surface of water or by becoming attached to 
waterfowl and grazing animals. Waterfowl, in particular, are strongly attracted to maturing plants 
and strip the seed from the culms with their bills (DiTomaso et al. 2013). This is likely the main 
method of long-distance seed dispersal. 

Waxy mannagrass is reported to compromise the integrity of vernal pools and threaten endemic 
and endangered plants (DiTomaso et al. 2013). Waxy mannagrass greatly reduces the amount 
of photosynthetically active radiation from the surface to the bottom of vernal pools throughout 
the season (Gerlach 2012). Dense waxy mannagrass invasions appear to eliminate or 
significantly reduce populations of all native annual plant species, such as Sacramento Orcutt 
grass, from vernal pools. In addition, waxy mannagrass produces a considerable fine root mass 
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on or just under the surface of the soil that can change nutrient cycling in the vernal pools and 
negatively impact vernal pool hydrology through increased transpiration. 

Studies of waxy mannagrass control techniques suggest that hand pulling or clipping the above-
ground portion of plants before they set seed may be one of the best management techniques, 
particularly in small areas that have not been heavily invaded (Gerlach 2012). Heavy continuous 
grazing of waxy mannagrass-invaded pools can greatly reduce cover of the weed, but also 
results in significant hoof punching that converts vegetation to spikerush (Eleocharis 
macrostachya), and an increase in the severity of algal blooms from nutrient addition (Gerlach 
2012). Weed whips could be an effective strategy to simulate grazing without the negative 
effects, particularly if a source of water is available to artificially manipulate the germination and 
growth of waxy mannagrass (Gerlach 2012).  

3. MANAGEMENT OBJECTIVES 
The vegetation metric to be used for monitoring at the Reserve is frequency, because frequency 
estimation is especially sensitive to changes in spatial arrangement, and CDFW is particularly 
interested in detecting changes in the spatial arrangement of Sacramento Orcutt grass and the 
invasive waxy mannagrass.  

Measuring above-ground expression of annual plant species such as Sacramento Orcutt grass 
provides a quantitative annual record of the populations; however, annual plant species 
populations are known to fluctuate in response to environmental conditions. Therefore, above-
ground expression of Sacramento Orcutt grass may not be a good metric for making short term 
management decisions. A management objective and response based on Sacramento Orcutt 
grass frequency will therefore not be used for adaptive management at this time, but may be 
added in the future, if considered necessary. Instead, the monitoring for adaptive management 
will focus on a habitat indicator that CDFW may have some management control over: 
frequency of waxy mannagrass (Glyceria declinata).  

The initial management objective is: 

 Maintain a frequency of 10 percent or less (1 m2 quadrat) of waxy mannagrass (Glyceria 
declinata) in Macroplot A and Macroplot B at Phoenix Field Ecological Reserve in every 
year. (This is a target/threshold type of management objective.)  

4. MONITORING DESIGN 

4.1. SPRING FREQUENCY MONITORING 

As part of the Monitoring Plan, nested frequency monitoring within two specific macroplots will 
be conducted, and monitoring photographs will be taken (Figure 5). The monitoring macroplots 
were deliberately placed to contain all Sacramento Orcutt grass plants found on the Reserve in 
2014; however, a few Sacramento Orcutt grass plants have been found just outside of the 
southeast corner of Macroplot B in some years. Upland areas within the two monitoring 
macroplots were excluded from the frequency evaluation because these areas are unsuitable 
for Sacramento Orcutt grass. The actual areas within the rectangular Macroplots that will be 
evaluated are presented in Figures 6 and 7 which also show the 1 meter2 (1 meter by 1 meter) 
frequency quadrats that were sampled in 2017. The nested frequency design also utilizes 0.25 
meter2 (0.5 meter by 0.5 meter) and 0.0625m2 (0.25 meter by 0.25 meter) quadrat sizes.  
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This protocol is designed to be completed by two to three monitors over two or three field days 
each year, and is designed to be easily accomplished by volunteers or CDFW staff with limited 
training. The monitoring should be conducted when both Sacramento Orcutt grass and waxy 
mannagrass are evident and easily identifiable, likely in May or June. A scouting visit to the 
Reserve should occur in late April or May. 

 SAMPLING OBJECTIVE 

The sampling objective is to be 90 percent confident that our frequency estimates are within +/-
10 percent of the actual frequency values. 

 BEFORE GOING INTO THE FIELD 

Determine the quadrats to sample using systematic random sampling, and fill in the appropriate 
quadrat locations on the Nested Frequency Data Sheets for Macroplots A and B. Examples of 
the 1m2 frequency quadrats sampled in 2017 can be seen in Figures 6 and 7.  

Print out all of the necessary data sheets. These include:  

 Photomonitoring Log, Phoenix Field Macroplot A 

 Photomonitoring Log, Phoenix Field Macroplot B 

 Photomonitoring Log, Phoenix Field Photopoint C 

 Nested Frequency Data Sheet, Phoenix Field Macroplot A  

 Nested Frequency Data Sheet, Phoenix Field Macroplot B 

 California Native Species Field Survey Form 

 Qualitative Monitoring Datasheet 

Reserve a date in late April or May for one or two people to check vernal pool water levels and 
see if Sacramento Orcutt grass is evident and identifiable. Also reserve several possible 
additional dates in mid-May and early June to do the monitoring. In 2014, the monitoring was 
conducted on June 5 and June 10; however, in that year it may have been better to conduct the 
monitoring approximately two weeks earlier. The weather can be very hot at this time of year, 
and the Reserve provides little shade. Plan to do the field work as early as possible in the 
morning to avoid excessive heat, and take breaks often. 

Contact the Reserve manager in the North Central Region office prior to the visit (Ms. Helayna 
Pera in 2017) and secure a key or ensure that you will be able to gain access to the Reserve.  

At least three people should plan to be at the site to do the monitoring, and it may take one to 
two days to complete. At least one of the monitors should be able to positively identify all of the 
plant species being monitored. All monitors should familiarize themselves with the species being 
monitored, the Reserve, this Monitoring Plan and the data that has been previously collected. 
Request field assistance from North Central Region staff, if necessary, and reserve vehicles for 
transportation. If desired, additional visits to the site to conduct the photomonitoring portions of 
the protocol may be scheduled in winter and spring. 

Gather the field equipment and materials listed in Figure 8.  

Frequency data will be collected on the following species or groups of species:  

 Waxy mannagrass (Glyceria declinata)  

 Spikerush (Eleocharis macrostachya) 

 Sacramento Orcutt grass (Orcuttia viscida), and 
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Figure 8: Equipment Checklist
 
Marking 

 Re-bar, ~50cm long, to replace any 
permanent field monuments that are 
missing 

 Lots of pin flags 
 Pink flagging 
 Pink spraypaint and disposable gloves 

 
Measuring 

 Meter tapes  
o Tape, at least 55m long (2+) 
o Tape, at least 25m long (1+) 

 Screwdrivers to anchor meter tapes  
 Retractable tape measure 
 Compass, set to the proper declination 

(16’east declination) 
 1m PVC quadrat, with 50cm and 25cm 

nested quadrats 
 
Documenting 

 Clipboards (2) 
 Data Sheets 

o Photomonitoring logs  
(for macroplots A and B) 

o Nested Frequency datasheets 
(for macroplots A and B) 

o Qualitative Monitoring Datasheet 
o California Native Species Field 

Survey Forms 
 Graph Paper 
 Field Notebook 

 Mechanical Pencils 
 Camera (with batteries, memory card, 

and lens with focal length of 
approximately 18mm (27mm on a “full 
frame” camera) 

 Tripod 
 
Other Tools 

 Sledgehammer 
 Leather Gloves  
 Hand Lens 
 Plant Dissection Kit 
 Plastic zip-lock bags 
 Plant Press with Newspaper, etc.  
 Calculator 
 Shade canopy or umbrella 
 Food and Water 
 Field Clothes 
 Weed-resistant footwear  

(e.g. leather boots) 
 Sharpie 
 Key to gate 

 
Reference 

 Monitoring Protocol with Appendices 
 Maps 
 The Jepson Manual 
 Other Floras/Guidebooks  
 Measuring and Monitoring Plant 

Populations Manual 
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 Any non-native plants other than waxy mannagrass. Non-native plants that may be 
encountered within macroplots include, but are not limited to:  

o Barbed goat grass (Aegilops triuncialis) 
o Pacific bent grass (Agrostis avenacea) 
o Silver hair grass (Aira caryophyllea) 
o Large quaking grass (Briza maxima) 
o Small quaking grass (Briza minor) 
o Ripgut grass (Bromus diandrus) 
o Soft chess (Bromus hordeaceus) 
o Bermuda grass (Cynodon dactylon) 
o Storksbill (Erodium spp.) 
o Rye grass (Festuca perennis) 
o Dwarf rush (Juncus capitatus) 
o Hairy hawkbit (Leontodon saxatilis ssp. longirostris) 
o Rabbitfoot grass (Polypogon monspeliensis) 
o Winter vetch (Vicia villosa) 

Section 9 contains a field identification aid for Sacramento Orcutt grass. Field identification aids 
for waxy mannagrass and other plant taxa are available via https://calphotos.berkeley.edu/. 
Additional species may be included in the frequency monitoring at any time in the future if 
CDFW decides that it may be useful or informative. If, for instance, a new plant begins 
encroaching into the vernal pool habitat, that plant should be monitored specifically. 
Alternatively if it becomes clear that the monitoring of a species is not contributing any useful 
information for the monitoring or management of the site, that species should no longer be 
monitored. 

 IN THE FIELD 

Locate Macroplots 

The driveway and access gate for the Reserve is right next to the house located at 9094 Shady 
Hollow Way, Fair Oaks, CA 95628. To get to the Reserve from Highway 50: 

 Travel 1.8 miles north on Hazel Avenue 

 Turn right on Sunset Avenue 

 Turn left on Runway Drive 

 Turn right on Aeronautic Way 

 Turn left on Tarmac Way 

 Turn right on Susan Oak Drive 

 Turn left on Shady Hollow Way 

 Turn right into the driveway for the Reserve 

Once at the Reserve, monitors should locate rebar monuments for macroplots A and B (see 
Figure 5). Macroplot A is located within a 25-meter by 56-meter rectangle that is marked with 
rebar that has been hammered into the ground at each of its four corners. To back-up the rebar 
monuments of Macroplot A, U-shaped metal stakes have been hammered flush to the ground to 
the north and south of each rebar monument.  

Macroplot B is located within a 27-meter by 49-meter rectangle that is marked with rebar that 
has been hammered into the ground at each of its four corners. Aluminum tags have also been 
attached to the monuments. To back-up the rebar monuments for macroplots, U-shaped metal 
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stakes have been hammered flush to the ground to the north and east of each rebar monument 
for Macroplot B.  

The macroplots were deliberately placed to encompass all Sacramento Orcutt grass plants that 
were found at the Reserve in 2014. The eight rebar monuments also serve as locations for the 
photomonitoring.  

If any of the rebar monuments are missing, they should be replaced before monitoring begins. If 
a rebar monument cannot be relocated, monitors should try to find the U-shaped metal stakes 
that were hammered into the ground near the location of the previous rebar monument. If a 
metal detector is available, it may aid in finding the U-shaped metal stakes. If a metal detector is 
not available and the U-shaped metal stakes cannot be found, the monitors should use meter 
tapes, the remaining rebar monuments and compass bearings to place new rebar monuments 
in the appropriate positions, and continue the monitoring. Monitors should also add additional 
back-up monuments if necessary. Any missing and replacement monuments should be 
documented in the field notes for the day. The coordinates of the plot monuments are presented 
in Table 1. Once the plot monuments have been located, use meter tapes and a compass to 
delineate the extent of the plots (see Figure 5). 

Macroplot 
Monument 

Latitude and Longitude 

Macroplot A, 
northeast corner 

38.6555637, -121.2147920 

Macroplot A, 
southeast corner 

38.6551308, -121.2145042 

Macroplot A, 
southwest corner 

38.6550184, -121.2147649 

Macroplot A, 
northwest corner 

38.6554639, -121.2150465 

Macroplot B, 
northeast corner 

38.6563218, -121.2153008 

Macroplot B, 
southeast corner 

38.6559229, -121.2150794 

Macroplot B, 
southwest corner 

38.6558282, -121.2153569 

Macroplot B, 
northwest corner 

38.6562324, -121.2155837 

Photopoint C 38.654772, -121.215667 

 

Table 1. Latitude and Longitude of Plot Monuments in Decimal Degrees 

 
Collect Data 

To set up the baseline meter tapes for macroplot A, monitors should loop the end of one of the 
longer meter tapes (at least 55m long) around the rebar monument at the northwest corner of 
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the macroplot. A monitor should walk the meter tape to the southwest corner of the macroplot, 
kicking down and trampling as many standing weeds as possible along the way, so that the 
meter tape comes as close as possible to laying directly on the ground and is not supported by 
dead vegetation. The monitor should wrap the loose end of the tape around the rebar 
monument at the northwest corner of the macroplot so that it stays in place, and leave the tape 
on the ground. The monitors should do the same thing with the other long meter tape (at least 
55m long), from the northeast corner of the macroplot to the southeast corner of the macroplot 
so that there are two parallel baselines.  

Setting up the baselines for Macroplot B is similar to setting them up for Macroplot A, except 
that monitors should lay one of the longer meter tapes (at least 55m long) from the monument at 
the southeast corner to the monument at the northeast corner, and from the monument at the 
southwest corner to the monument at the northwest corner. 

One of the monitors should hold the components for the nested PVC quadrat frame and one of 
the monitors should hold the clipboard with the Nested Frequency datasheets. Monitors should 
do the following to collect the nested frequency monitoring data: 

1. Lay the short meter tape (at least 25m long) so that it intersects both of the baselines at 
the appropriate location for each transect identified on the Nested Frequency 
datasheets. For example, the first transect of Macroplot A (Transect A) the short meter 
tape could begin 1 meter along the baseline from the northwest corner, and be laid along 
the ground so that it crosses the other baseline at 1 meter from the northeast (See 
Figure 6). Use a screwdriver stuck in the ground or other object as the anchor point for 
the beginning of the meter tape. Try to avoid trampling the northeast corner of macroplot 
B before data is collected there. 

2. Lay the PVC Quadrat Frame so that the bottom left corner of the 1 m2 frame opening is 
at the distance along the transect indicated on the Nested Frequency datasheet. The 
quadrat should always be laid so that the smallest of the nested quadrats (0.25 m2) is in 
the bottom left corner of the frame (Figure 9). Lay down the 0.5 m2 and 0.25 m2 right-
angle PVC inserts as needed. If the quadrat falls on a slope hold the quadrat frame in 
position horizontally as close as possible to the ground, and imagine that the frame is 
projected straight down upon the ground.    

3. Look for the plants being monitored within each of the quadrat frame sizes. The following 
rules should be followed when looking for plants: 

• Only the area inside of the PVC quadrat frame as viewed from above is 
considered for determining presence/absence. If a plant only occurs underneath 
the PVC quadrat frame, then the plant is considered to be absent from the 
quadrat.  

• Only the portion of the plant where the stem meets the ground (rooted area) is 
considered for determining presence/absence. If a plant is rooted to the ground 
outside of the PVC quadrat frame, but branches of the plant fall within the PVC 
quadrat frame, the plant is considered to be absent from the quadrat. 

• Data should only be collected for plants that are determined to be from the current 
season’s growth. Plant carcasses from the previous year should not be 
considered as plants for the purpose of determining presence/absence. 
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Figure 9. Nested Frequency Quadrats 

 
4. Record presence/absence data on the appropriate datasheet for each of the species 

being monitored. For each quadrat listed on the nested frequency datasheet, the 
monitors should record a 0, 1, 2 or 3 for the species as follows: 

• “0” if no plants of that species are within the entire 1 m2 PVC quadrat frame 
• “1” if plants of that species are within the 0.25 m2 section of the PVC quadrat 

frame 
• “2” if plants of that species are within the 0.5 m2 section of the PVC quadrat frame 

but not 0.25 m2 section of the PVC quadrat frame 
• “3” if plants of that species are within the 1 m2 section of the PVC quadrat frame 

but not the 0.25 m2 or 0.5 m2 sections of the PVC quadrat frame.  

Complete a qualitative monitoring datasheet and take monitoring photos for each macroplot that 
data was collected from before leaving the field site (see Section 4.2).  

 BACK IN THE OFFICE 

 Scan, save and re-name all field data sheets. The current project folder is: 
U:\groups\HCPB\Shared Folders\NPP\Section 6\2014\Priority Plant Surveys\Project 
Files\Phoenix Field Files. This project folder is likely to change in the future.  

 Enter the field data into excel spreadsheets, perform quality control and analyze the 
data. Chi square tests should be performed to test whether or not a significant change in 
frequency has occurred between two years (Elzinga et al. 1998). 

 Compare the results with previous years results and make graphs of the data (Elzinga et 
al. 1998). Make conclusions. Talk to the Reserve manager about adaptive management 
of the site. This is the most important part of adaptive management! 

 Download and rename field photos (Section 4.2) and compare them with monitoring 
photos from previous years.  
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4.2. ANNUAL PHOTOMONITORING FOR ADAPTIVE MANAGEMENT 

Photomonitoring should be conducted for a macroplotplot whenever data is collected for that 
macroplot, or whenever you would like to quickly document the condition of the Reserve. If the 
Reserve is visited when the rare pincushion navarretia is blooming (likely in April and/or May) 
monitoring photographs should also be taken at Photopoint C, and a California Natural Diversity 
Database field survey form should be completed for pincushion navarretia. The pincushion 
navarretia population that was present in 2016 is located at approximately 38.654427°, -
121.215506°.  

 BEFORE GOING INTO THE FIELD 

The monitor conducting the photomonitoring should be trained and familiar with the proper use 
of a field compass and whatever digital camera and tripod will be used. The following equipment 
is required: 

 Clipboard with photomonitoring log sheets (Section 9)  

 Pen or pencil 

 Digital camera with fully-charged batteries and available memory: a compact digital SLR 
camera with a standard 18-55mm zoom lens is preferred for ease of photo comparison.  

 Tripod  

 Compass set to the correct declination for the site (16 degrees east) 

To duplicate approximately the same field of view from year to year, the camera should be set 
to a focal length that is equivalent to a focal length of approximately 27mm on a “full frame” 
camera such as a 35mm film camera or a Nikon “FX” camera and lens. Monitoring photographs 
for the initial 2014 photomonitoring were taken using a Nikon “DX” camera and lens, set to a 
focal length of 18mm, which is equivalent to 27 mm on a “full frame” camera and lens. Before 
visiting the site, check the specifications for digital cameras that may be used for the monitoring 
to see if photographs can be taken with the correct field of view. If the camera equipment to be 
used cannot duplicate this field of view, the closest field of view possible should be used.  

 IN THE FIELD 

All monitoring photographs are taken from a plot monument. Refer to the photomonitoring 
datasheet (Section 9) for the locations of monuments, and the order that monitoring photos 
should be taken. Once at the location of the monitoring photograph, do the following: 

 Set up the tripod and camera so that the center of the camera lens is 5 feet (152cm) 
above the ground (the maximum height for many tripods), and directly above the 
appropriate location on the ground.  

 Populate Each Page of the Photomonitoring Log with the date, photographer name, 
focal length, camera, lens and camera settings, and any other relevant information.  

 Take a “Slate” Photo of the first page of the Photomonitoring Log sheet itself before 
taking all of the monitoring photos on that page. Take a photo of the next page of the 
Photomonitoring Log before taking all of the photos that are listed on that page, and so 
on, until all monitoring photos have been taken. 

 Take monitoring photos in the order that they are listed on the photomonitoring 
datasheet. Follow these rules: 

o Use the field compass to ensure that all photos are taken in the direction 
indicated in the Photomonitoring Log. 
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o Make sure that the camera’s zoom lens is set to the correct focal length (e.g. 18 
mm on a Nikon d3100/d3300). 

o Set up the camera so that the horizon is 1/4 of the way down from the top of the 
frame. Many cameras have a focus point at this location within the viewfinder.  

o Make sure the horizon in the viewfinder is as horizontal as possible.  
o Make sure that the camera focuses properly before taking the picture, and use 

the preview function of the camera to make sure that the photo has been taken 
correctly. 

    

    

    

    

Center the horizon in the camera viewfinder at the area indicated with the red arrow 

 BACK IN THE OFFICE 

Save all monitoring photos in the in a folder on the shared drive that corresponds with the date 
of the field visit, for example: “U:\groups\HCPB\Shared Folders\NPP\Section 6\2014\Priority 
Plant Surveys\Project Files\Phoenix Field Files\Monitoring Data\2017\20170607”  

Carefully change the names of the photo files using the following convention: [uppercase letter 
of plot][lowercase letter of the photopoint][four digit year][two digit month][two digit day of the 
month]. For example if a photo is taken at Photopoint a of Macroplot B, on June 7, 2017 the file 
should be named “Ba20170607”. 

All properly named monitoring photos should be saved in the following folder on the shared 
drive: U:\groups\HCPB\Shared Folders\NPP\Section 6\2014\Priority Plant Surveys\Project 
Files\Phoenix Field Files\Put all renamed monitoring photos here. The location of this folder may 
change in the future. 

With the monitoring photos saved, use the Windows Photo Viewer program and the left and 
right arrow keys on the keyboard to compare monitoring photos with those taken during 
previous site visits and look for signs of excessive impacts from grazing and other differences in 
site condition. If the monitoring photos are misaligned, it may be difficult to interpret the 
differences between monitoring photos. It is possible to align the monitoring photos more 
precisely by carefully manipulating them using Photoshop or other photo editing software. This 
is helpful for showing precisely how specific areas of the ground (e.g. a gopher mound or group 
of cobbles) have changed over the years. Guidelines for aligning monitoring photos using 
Photoshop CS6 is provided as an appendix to this Monitoring Plan.  

Talk to the Reserve manager about the management of the site. This is the most important 
part of adaptive management! 
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5. RESPONSIBLE PARTIES 
CDFW staff in the Native Plant Program or North Central Region (Region 2) should implement 
this Monitoring Plan and report results and recommended actions annually to the Reserve 
manager. The Reserve manager should make decisions on how to adaptively manage the 
Reserve. 

6. FUNDING 
CDFW staff in the Native Plant Program used grant funding from the U.S. Fish and Wildlife 
Service Cooperative Endangered Species Conservation Fund (F15AP00059) and other funding 
sources including funds from the Rare and Endangered Species Preservation Fund to prepare 
this Monitoring Plan and collect monitoring data. Collection of pilot data in 2014 was funded by 
the Rare and Endangered Species Preservation Fund. CDFW staff in the Native Plant Program 
are expected to continue implementation of this Monitoring Plan from 2018 to 2021, funded by 
another grant from the U.S. Fish and Wildlife Service Cooperative Endangered Species 
Conservation Fund. Continuation of this Monitoring Plan after 2021 is likely dependent on the 
ability of staff in the Native Plant Program to use staff time funded by the Rare and Endangered 
Species Preservation Fund, general fund, and other programs to do so. Field helpers can often 
be borrowed from other CDFW programs if the appropriate program managers approve the 
work as cross training for their staff. Implementation of this Monitoring Plan could also be 
implemented by staff in CDFW’s North Central Region or by CDFW volunteers. It is estimated 
that annual implementation of this Monitoring Plan will require the following: 

In-office preparations: 16 hours by one environmental scientist or senior environmental scientist 
(specialist) = 16 hours 

Field visit to check phenology (optional): 8 hours by one environmental scientist or senior 
environmental scientist (specialist) and one other field helper = 16 hours 

Field visits to collect data: 16 hours by one environmental scientist or senior environmental 
scientist (specialist) and two or three other field helpers = 56 hours 

In-office data analysis and reporting: 24 hours by one environmental scientist or senior 
environmental scientist (specialist) = 24 hours 

TOTAL STAFF TIME NEEDED: Approximately 112 hours per year 

Preparation of periodic summary reports and presentation of results will likely require additional 
time. A summary report for 2015-2017 has been prepared, and another summary report will be 
prepared in 2021 that will cover the period from 2015-2021. Prepare a summary report no less 
frequently than every third year of monitoring. 

7. MANAGEMENT IMPLICATIONS OF POTENTIAL 

RESULTS 
Management Implication 1: If any portion of the 90 percent confidence interval for waxy 
mannagrass frequency (1 meter2) exceeds 10 percent in Macroplot A or Macroplot B, CDFW 
shall organize and initiate a waxy mannagrass cutting effort in the following year, before waxy 
mannagrass seeds have set.   
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The management implication above can be changed at any time in the future, if deemed 
necessary. For example, the 10 percent (1 meter2) frequency threshold of waxy mannagrass to 
trigger a management response could be increased to 15 percent is CDFW wanted to reduce 
management effort at the Reserve, or the frequency threshold could be decreased to five 
percent if CDFW wanted to significantly reduce or eliminate the amount of waxy mannagrass on 
the reserve by cutting mannagrass more frequently.  

Additional management implications can also be added at any time in the future, but any 
additional management implications should be documented in future monitoring reports, and 
related to monitoring.  

Furthermore, monitoring methods can be changed in the future, as necessary, to adapt to new 
threats or changing conditions. This monitoring plan is intended to lay a strong foundation for 
management of the Reserve, but is also intended to be adaptive to new threats and changing 
conditions. 
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1

2

3 0

0 1

Randomly select a transect start: 0m 1m 2m

1 2 3 4 5 6 7 8

Waxy Mannagrass

Eleocharis macrostachya

Sacramento Orcutt Grass

Other Invasive

Waxy Mannagrass

Eleocharis macrostachya

Sacramento Orcutt Grass

Other Invasive

Waxy Mannagrass

Eleocharis macrostachya

Sacramento Orcutt Grass

Other Invasive

Quadrat Number

Greyed out quadrat cell are 

outside of the vernal pool and 

were excluded (see figures in 

the monitoring plan)

Nested Frequency Data Sheet: Phoenix Field Macroplot A

Randomly pick a 1, 2 or 3m start for Quad1 (NOT 0, 1 or 2: see map), then place other 

quads systematically (add 3m to the start for each consecutive quad)-->

Nested Quadrat Codes:

present in 25 cm x 25 cm area

present in 50 cm x 50cm area

ORVI

OI

GLDE

3

A

B

C

Randomly pick a 1, 2 or 3m start for Quad1 (NOT 0, 1 or 2: see map), then place other 

quads systematically (add 3m to the start for each consecutive quad)-->

Species Code Description Transect

____ m
(use random 

start distance 

selected above)

____ m
(add 3m to start 

distance selected 

above)

Randomly pick a 1, 2 or 3m start for Quad1 (NOT 0, 1 or 2: see map), then place other 

quads systematically (add 3m to the start for each consecutive quad)-->

Date:

Field Personnel:

Nested Qudrat Code

____ m
(add 6m to start 

distance selected 

above)

present in 100 cm x 100 cm area

Not Present

2

ELMA

ORVI

OI

GLDE

ELMA

ORVI

OI

GLDE

ELMA
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1

2

3 0

0 1

transect start from page 1: 0m 1m 2m

1 2 3 4 5 6 7 8

Waxy Mannagrass

Eleocharis macrostachya

Sacramento Orcutt Grass

Other Invasive

Waxy Mannagrass

Eleocharis macrostachya

Sacramento Orcutt Grass

Other Invasive

Waxy Mannagrass

Eleocharis macrostachya

Sacramento Orcutt Grass

Other Invasive

(add 12m to 

start distance 

above)

Randomly pick a 1, 2 or 3m start for Quad1 (NOT 0, 1 or 2: see map), then place other 

quads systematically (add 3m to the start for each consecutive quad)-->

F
ELMA

____ m
(add 15m to 

start distance 

above)

Greyed out quadrat cell are 

outside of the vernal pool and 

were excluded (see figures in 

the monitoring plan)

Quadrat Number

Randomly pick a 1, 2 or 3m start for Quad1 (NOT 0, 1 or 2: see map), then place other 

quads systematically (add 3m to the start for each consecutive quad)-->

GLDE

ELMA

____ m
(add 9m to start 

distance above)

Randomly pick a 1, 2 or 3m start for Quad1 (NOT 0, 1 or 2: see map), then place other 

quads systematically (add 3m to the start for each consecutive quad)-->

E
ELMA

____ m

present in 100 cm x 100 cm area 2

Not Present

D

Nested Qudrat Code

Species Code Description Transect

ORVI

OI

GLDE

ORVI

OI

GLDE

Nested Frequency Data Sheet: Phoenix Field Macroplot A

Date:

Field Personnel:

Nested Quadrat Codes:

present in 25 cm x 25 cm area

3present in 50 cm x 50cm area

ORVI

OI



Page 3 of 6

1

2

3 0

0 1

transect start from page 1: 0m 1m 2m

1 2 3 4 5 6 7 8

Waxy Mannagrass

Eleocharis macrostachya

Sacramento Orcutt Grass

Other Invasive

Waxy Mannagrass

Eleocharis macrostachya

Sacramento Orcutt Grass

Other Invasive

Waxy Mannagrass

Eleocharis macrostachya

Sacramento Orcutt Grass

Other Invasive

Randomly pick a 1, 2 or 3m start for Quad1 (NOT 0, 1 or 2: see map), then place other 

quads systematically (add 3m to the start for each consecutive quad)-->

I

____ m
(add 24m to 

start distance 

above)

GLDE

ELMA

ORVI

OI

Nested Frequency Data Sheet: Phoenix Field Macroplot A

Date:

Field Personnel:

Nested Quadrat Codes:

present in 25 cm x 25 cm area

3present in 50 cm x 50cm area Greyed out quadrat cell are 

outside of the vernal pool and 

were excluded (see figures in 

the monitoring plan)

present in 100 cm x 100 cm area 2

ORVI

ELMA

____ m

Nested Qudrat Code

Not Present

Species Code Description Transect
Quadrat Number

Randomly pick a 1, 2 or 3m start for Quad1 (NOT 0, 1 or 2: see map), then place other 

quads systematically (add 3m to the start for each consecutive quad)-->

GLDE G

GLDE

ELMA

ORVI

OI

OI
(add 18m to 

start distance 

above)

Randomly pick a 1, 2 or 3m start for Quad1 (NOT 0, 1 or 2: see map), then place other 

quads systematically (add 3m to the start for each consecutive quad)-->

H

____ m
(add 21m to 

start distance 

above)



Page 4 of 6

1

2

3 0

0 1

transect start from page 1: 0m 1m 2m

1 2 3 4 5 6 7 8

Waxy Mannagrass

Eleocharis macrostachya

Sacramento Orcutt Grass

Other Invasive

Waxy Mannagrass

Eleocharis macrostachya

Sacramento Orcutt Grass

Other Invasive

Waxy Mannagrass

Eleocharis macrostachya

Sacramento Orcutt Grass

Other Invasive

Species Code Description Transect
Quadrat Number

Randomly pick a 1, 2 or 3m start for Quad1 (NOT 0, 1 or 2: see map), then place other 

quads systematically (add 3m to the start for each consecutive quad)-->

GLDE J

Nested Qudrat Code

Nested Frequency Data Sheet: Phoenix Field Macroplot A

Date:

Field Personnel:

Nested Quadrat Codes:

present in 25 cm x 25 cm area

3present in 50 cm x 50cm area Greyed out quadrat cell are 

outside of the vernal pool and 

were excluded (see figures in 

the monitoring plan)

present in 100 cm x 100 cm area 2

Not Present

ELMA

____ mORVI

OI
(add 27m to 

start distance 

above)

ELMA

ORVI

OI

ELMA

ORVI

OI

Randomly pick a 1, 2 or 3m start for Quad1 (NOT 0, 1 or 2: see map), then place other 

quads systematically (add 3m to the start for each consecutive quad)-->

GLDE K

____ m
(add 30m to 

start distance 

above)

Randomly pick a 1, 2 or 3m start for Quad1 (NOT 0, 1 or 2: see map), then place other 

quads systematically (add 3m to the start for each consecutive quad)-->

GLDE L

____ m
(add 33m to 

start distance 

above)



Page 5 of 6

1

2

3 0

0 1

transect start from page 1: 0m 1m 2m

1 2 3 4 5 6 7 8

Waxy Mannagrass

Eleocharis macrostachya

Sacramento Orcutt Grass

Other Invasive

Waxy Mannagrass

Eleocharis macrostachya

Sacramento Orcutt Grass

Other Invasive

Waxy Mannagrass

Eleocharis macrostachya

Sacramento Orcutt Grass

Other Invasive

Nested Frequency Data Sheet: Phoenix Field Macroplot A

Date:

Field Personnel:

OI

OI
(add 39m to 

start distance 

above)

Randomly pick a 1, 2 or 3m start for Quad1 (NOT 0, 1 or 2: see map), then place other 

quads systematically (add 3m to the start for each consecutive quad)-->

O

____ m
(add 42m to 

start distance 

above)

ORVI

OI
(add 36m to 

start distance 

above)

Randomly pick a 1, 2 or 3m start for Quad1 (NOT 0, 1 or 2: see map), then place other 

quads systematically (add 3m to the start for each consecutive quad)-->

Description Transect
Quadrat Number

Nested Quadrat Codes:

present in 25 cm x 25 cm area

3present in 50 cm x 50cm area Greyed out quadrat cell are 

outside of the vernal pool and 

were excluded (see figures in 

the monitoring plan)

present in 100 cm x 100 cm area 2

Not Present

Species Code

Nested Qudrat Code

GLDE

ELMA

ORVI

Randomly pick a 1, 2 or 3m start for Quad1 (NOT 0, 1 or 2: see map), then place other 

quads systematically (add 3m to the start for each consecutive quad)-->

GLDE M
ELMA

____ mORVI

N
ELMA

____ m

GLDE



Page 6 of 6

1

2

3 0

0 1

transect start from page 1: 0m 1m 2m

1 2 3 4 5 6 7 8

Waxy Mannagrass

Eleocharis macrostachya

Sacramento Orcutt Grass

Other Invasive

Waxy Mannagrass

Eleocharis macrostachya

Sacramento Orcutt Grass

Other Invasive

Species Code Description Transect
Quadrat Number

Nested Qudrat Code

Randomly pick a 1, 2 or 3m start for Quad1 (NOT 0, 1 or 2: see map), then place other 

quads systematically (add 3m to the start for each consecutive quad)-->

GLDE P
ELMA

____ mORVI

OI
(add 45m to 

start distance 

above)

Randomly pick a 1, 2 or 3m start for Quad1 (NOT 0, 1 or 2: see map), then place other 

quads systematically (add 3m to the start for each consecutive quad)-->

GLDE Q
ELMA

____ mORVI

OI
(add 48m to 

start distance 

above)

Nested Quadrat Codes:

present in 25 cm x 25 cm area

3present in 50 cm x 50cm area

Greyed out quadrat cell are 

outside of the vernal pool and 

were excluded (see figures in 

the monitoring plan)

present in 100 cm x 100 cm area 2

Not Present

Nested Frequency Data Sheet: Phoenix Field Macroplot A

Date:

Field Personnel:



Page 1 of 6

1

2

3 0

0 1

Randomly select a transect start: 0m 1m 2m

1 2 3 4 5 6 7 8

Waxy Mannagrass

Eleocharis macrostachya

Sacramento Orcutt Grass

Other Invasive

Waxy Mannagrass

Eleocharis macrostachya

Sacramento Orcutt Grass

Other Invasive

Waxy Mannagrass

Eleocharis macrostachya

Sacramento Orcutt Grass

Other Invasive

Quadrat Number

Greyed out quadrat cell are 

outside of the vernal pool and 

were excluded (see figures in 

the monitoring plan)

Nested Frequency Data Sheet: Phoenix Field Macroplot B

Randomly pick a 0, 1, or 2m start for Quad1, then place other quads systematically 

(add 3m to the start for each consecutive quad)-->

Nested Quadrat Codes:

present in 25 cm x 25 cm area

present in 50 cm x 50cm area

ORVI

OI

GLDE

3

A

B

C

Randomly pick a 0, 1, or 2m start for Quad1, then place other quads systematically 

(add 3m to the start for each consecutive quad)-->

Species Code Description Transect

____ m
(use random 

start distance 

selected above)

____ m
(add 3m to start 

distance selected 

above)

Randomly pick a 0, 1, or 2m start for Quad1, then place other quads systematically 

(add 3m to the start for each consecutive quad)-->

Date:

Field Personnel:

____ m
(add 6m to start 

distance selected 

above)

present in 100 cm x 100 cm area

Not Present

2

ELMA

ORVI

OI

GLDE

ELMA

ORVI

OI

GLDE

ELMA



Page 2 of 6

1

2

3 0

0 1

transect start from page 1: 0m 1m 2m

1 2 3 4 5 6 7 8

Waxy Mannagrass

Eleocharis macrostachya

Sacramento Orcutt Grass

Other Invasive

Waxy Mannagrass

Eleocharis macrostachya

Sacramento Orcutt Grass

Other Invasive

Waxy Mannagrass

Eleocharis macrostachya

Sacramento Orcutt Grass

Other Invasive

F
ELMA

____ m
(add 15m to 

start distance 

above)

Greyed out quadrat cell are 

outside of the vernal pool and 

were excluded (see figures in 

the monitoring plan)

Quadrat Number

Randomly pick a 0, 1, or 2m start for Quad1, then place other quads systematically 

(add 3m to the start for each consecutive quad)-->

GLDE

ELMA

____ m
(add 9m to start 

distance above)

Randomly pick a 0, 1, or 2m start for Quad1, then place other quads systematically 

(add 3m to the start for each consecutive quad)-->

E
ELMA

____ m

present in 100 cm x 100 cm area 2

Not Present

Nested Quadrat Code

D

Species Code Description Transect

Nested Frequency Data Sheet: Phoenix Field Macroplot B

Date:

ORVI

OI

GLDE

ORVI

OI

GLDE

Field Personnel:

Nested Quadrat Codes:

present in 25 cm x 25 cm area

3present in 50 cm x 50cm area

(add 12m to 

start distance 

above)

Randomly pick a 0, 1, or 2m start for Quad1, then place other quads systematically 

(add 3m to the start for each consecutive quad)-->

ORVI

OI



Page 3 of 6

1

2

3 0

0 1

transect start from page 1: 0m 1m 2m

1 2 3 4 5 6 7 8

Waxy Mannagrass

Eleocharis macrostachya

Sacramento Orcutt Grass

Other Invasive

Waxy Mannagrass

Eleocharis macrostachya

Sacramento Orcutt Grass

Other Invasive

Waxy Mannagrass

Eleocharis macrostachya

Sacramento Orcutt Grass

Other Invasive

Randomly pick a 0, 1, or 2m start for Quad1, then place other quads systematically 

(add 3m to the start for each consecutive quad)-->

I

____ m
(add 24m to 

start distance 

above)

GLDE

ELMA

ORVI

OI

Nested Frequency Data Sheet: Phoenix Field Macroplot B

Date:

Field Personnel:

Nested Quadrat Codes:

present in 25 cm x 25 cm area

3present in 50 cm x 50cm area Greyed out quadrat cell are 

outside of the vernal pool and 

were excluded (see figures in 

the monitoring plan)

present in 100 cm x 100 cm area 2

ORVI

ELMA

____ m

Not Present

Species Code Description Transect
Quadrat Number

Randomly pick a 0, 1, or 2m start for Quad1, then place other quads systematically 

(add 3m to the start for each consecutive quad)-->

GLDE G

Nested Quadrat Code

GLDE

ELMA

ORVI

OI

OI
(add 18m to 

start distance 

above)

Randomly pick a 0, 1, or 2m start for Quad1, then place other quads systematically 

(add 3m to the start for each consecutive quad)-->

H

____ m
(add 21m to 

start distance 

above)



Page 4 of 6

1

2

3 0

0 1

transect start from page 1: 0m 1m 2m

1 2 3 4 5 6 7 8

Waxy Mannagrass

Eleocharis macrostachya

Sacramento Orcutt Grass

Other Invasive

Waxy Mannagrass

Eleocharis macrostachya

Sacramento Orcutt Grass

Other Invasive

Waxy Mannagrass

Eleocharis macrostachya

Sacramento Orcutt Grass

Other Invasive

Species Code Description Transect
Quadrat Number

Randomly pick a 0, 1, or 2m start for Quad1, then place other quads systematically 

(add 3m to the start for each consecutive quad)-->

GLDE J

Nested Quadrat Code

Nested Frequency Data Sheet: Phoenix Field Macroplot B

Date:

Field Personnel:

Nested Quadrat Codes:

present in 25 cm x 25 cm area

3present in 50 cm x 50cm area Greyed out quadrat cell are 

outside of the vernal pool and 

were excluded (see figures in 

the monitoring plan)

present in 100 cm x 100 cm area 2

Not Present

ELMA

____ mORVI

OI
(add 27m to 

start distance 

above)

ELMA

ORVI

OI

ELMA

ORVI

OI

Randomly pick a 0, 1, or 2m start for Quad1, then place other quads systematically 

(add 3m to the start for each consecutive quad)-->

GLDE K

____ m
(add 30m to 

start distance 

above)

Randomly pick a 0, 1, or 2m start for Quad1, then place other quads systematically 

(add 3m to the start for each consecutive quad)-->

GLDE L

____ m
(add 33m to 

start distance 

above)



Page 5 of 6

1

2

3 0

0 1

transect start from page 1: 0m 1m 2m

1 2 3 4 5 6 7 8

Waxy Mannagrass

Eleocharis macrostachya

Sacramento Orcutt Grass

Other Invasive

Waxy Mannagrass

Eleocharis macrostachya

Sacramento Orcutt Grass

Other Invasive

Waxy Mannagrass

Eleocharis macrostachya

Sacramento Orcutt Grass

Other Invasive

Nested Frequency Data Sheet: Phoenix Field Macroplot B

Date:

Field Personnel:

Description Transect
Quadrat Number

Nested Quadrat Code

Nested Quadrat Codes:

present in 25 cm x 25 cm area

3present in 50 cm x 50cm area Greyed out quadrat cell are 

outside of the vernal pool and 

were excluded (see figures in 

the monitoring plan)

present in 100 cm x 100 cm area 2

Not Present

Species Code

Randomly pick a 0, 1, or 2m start for Quad1, then place other quads systematically 

(add 3m to the start for each consecutive quad)-->

GLDE M
ELMA

____ mORVI

GLDE

ELMA

ORVI

ORVI

OI
(add 36m to 

start distance 

above)

Randomly pick a 0, 1, or 2m start for Quad1, then place other quads systematically 

(add 3m to the start for each consecutive quad)-->

GLDE N
ELMA

____ m

OI

OI
(add 39m to 

start distance 

above)

Randomly pick a 0, 1, or 2m start for Quad1, then place other quads systematically 

(add 3m to the start for each consecutive quad)-->

O

____ m
(add 42m to 

start distance 

above)



Page 6 of 6

1

2

3 0

0 1

transect start from page 1: 0m 1m 2m

1 2 3 4 5 6 7 8

Waxy Mannagrass

Eleocharis macrostachya

Sacramento Orcutt Grass

Other Invasive

ELMA

____ mORVI

OI
(add 45m to 

start distance 

above)

Species Code Description Transect
Quadrat Number

Randomly pick a 0, 1, or 2m start for Quad1, then place other quads systematically 

(add 3m to the start for each consecutive quad)-->

GLDE P

Nested Quadrat Code

Nested Frequency Data Sheet: Phoenix Field Macroplot B

Date:

Field Personnel:

Nested Quadrat Codes:

present in 25 cm x 25 cm area

3present in 50 cm x 50cm area

Greyed out quadrat cell are 

outside of the vernal pool and 

were excluded (see figures in 

the monitoring plan)

present in 100 cm x 100 cm area 2

Not Present
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Photomonitoring Log: Phoenix Field Macroplot A 

Shoot all with a focal length equivalent to 27mm on a full frame camera (e.g. 18mm on a Nikon dx lens). 

All photos should be shot from 5 feet above the ground, and the subject should be centered in the 

center and top 1/4 of the frame.  

Date of observation:    Camera and Lens:   

Observer(s): __________________________ Focal Length:______ Camera Setting: ____________ 

 

Photo 
point 

From Toward Description/Notes Photo file name in 
camera 

a NW Marker Center of pool   

b NW Marker NE Marker 

(bearing 60) 

  

c NW Marker SE Marker 

(bearing 120) 

  

d NW Marker SW Marker 

(bearing 160) 

  

e NW Marker Opposite of pool 

(bearing 300) 

  

f NE Marker Center of pool   

g NE Marker SE Marker 

(bearing 140) 

  

h NE Marker SW Marker 

(bearing 180) 

  

i NE Marker NW Marker 

(bearing 240) 

  

j NE Marker Opposite of pool 

(bearing 0) 

  

 



Page 1 of 2 

Photomonitoring Log: Phoenix Field Macroplot A 

Shoot all with a focal length equivalent to 27mm on a full frame camera (e.g. 18mm on a Nikon dx lens). 

All photos should be shot from 5 feet above the ground, and the subject should be centered in the 

center and top 1/4 of the frame.  

Date of observation:    Camera and Lens:   

Observer(s): __________________________ Focal Length:______ Camera Setting: ____________ 

k SE Marker Center of pool   

l SE Marker SW Marker 

(bearing 240) 

  

m SE Marker NW Marker 

(bearing 320) 

  

n SE Marker NE Marker 

(bearing 340) 

  

o SE Marker Opposite of pool 

(bearing 140) 

  

p SW Marker Center of pool   

q SW Marker NW Marker 

(bearing 340) 

  

r SW Marker NE Marker 

(bearing 0) 

  

s SW Marker SE Marker 

(bearing 60)  

  

t SW Marker Opposite of pool 

(bearing 180) 

  

     

 



Page 1 of 2 

Photomonitoring Log: Phoenix Field Macroplot B 

Shoot all with a focal length equivalent to 27mm on a full frame camera (e.g. 18mm on a Nikon dx lens). 

All photos should be shot from 5 feet above the ground, and the subject should be centered in the 

center and top 1/4 of the frame.  

Date of observation:    Camera and Lens:     

  

Observer(s): __________________________ Focal Length:______ Camera Setting: ____________ 

 

Photo 
point 

From Toward Description/Notes Photo file name in 
camera 

a NW Marker Center of pool   

b NW Marker NE Marker 

(bearing 70) 

  

c NW Marker SE Marker 

(bearing 130) 

  

d NW Marker SW Marker 

(bearing 170) 

  

e NW Marker Opposite of pool 

(bearing 310) 

  

f NE Marker Center of pool   

g NE Marker SE Marker 

(bearing 150) 

  

h NE Marker SW Marker 

(bearing 190) 

  

i NE Marker NW Marker 

(bearing 250) 

  

j NE Marker Opposite of pool 

(bearing 10) 
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Photomonitoring Log: Phoenix Field Macroplot B 

Shoot all with a focal length equivalent to 27mm on a full frame camera (e.g. 18mm on a Nikon dx lens). 

All photos should be shot from 5 feet above the ground, and the subject should be centered in the 

center and top 1/4 of the frame.  

Date of observation:    Camera and Lens:     

  

Observer(s): __________________________ Focal Length:______ Camera Setting: ____________ 

k SE Marker Center of pool   

l SE Marker SW Marker 

(bearing 250) 

  

m SE Marker NW Marker 

(bearing 330) 

  

n SE Marker NE Marker 

(bearing 350) 

  

o SE Marker Opposite of pool 

(bearing 150) 

  

p SW Marker Center of pool   

q SW Marker NW Marker 

(bearing 350) 

  

r SW Marker NE Marker 

(bearing 10) 

  

s SW Marker SE Marker 

(bearing 70)  

  

t SW Marker Opposite of pool 

(bearing 190) 

  

 

 



Photomonitoring Log: Phoenix Field Photopoint C 

Shoot all with a focal length equivalent to 27mm on a full frame camera (e.g. 18mm on a Nikon dx lens). 

All photos should be shot from 5 feet above the ground, and the subject should be centered in the 

center and top 1/4 of the frame.  

Date of observation:    Camera and Lens:   

Observer(s): __________________________ Focal Length:______ Camera Setting: ____________ 

Photopoint established west of the pool with Navarretia myersii subsp. myersii, 2 meters north east of a 

blue oak tree. Monument located at 38°39’17.18”, -121°12’56.40” 

Photo 
point 

From Toward Description/Notes Photo file name in 
camera 

a Plot C 
monument 

Southeast 

(135) 

  

b Plot C 
monument 

East (90)   

c Plot C 
monument 

Northeast (45)   

 



California Department of Fish and Wildlife Phoenix Field Ecological Reserve Qualitative Monitoring 

Date:       Weather: 

 

Field personnel: 

 

Location(s) visited: 

 

 

 

Describe the phonological condition of vegetation, soil saturation, soil disturbance, water levels and levels of 

residual dry matter: 

 

 

 

 

 

 

Describe any particularly abundant or notable plants or wildlife observed, including the abundance of Sacramento 

orcutt grass and pincushion navarretia: 

 

 

 

 

 

 

 

Describe visible threats and disturbances and any missing field markers: 

 

 

 

 

 

Describe weed infestations and the condition of trees and non-native species growing along perimeter fences: 

 

 

 

 

 

Describe any evidence of trespassing: 

 

 

Photographs taken: 

 

 

Recommendations: 



Partial Plant Species List for Phoenix Field Ecological Reserve updated 7/6/2018

Family  Genus Species Variety or Subspecies Common Name
Native 

(Yes/No)

Agavaceae Chlorogalum angustifolium narrow-leaved soaproot Y

Agavaceae Chlorogalum pomeridianum soap plant Y

Apiaceae Eryngium vaseyi coyote-thistle Y

Apiaceae Lomatium caruifolium var. denticulatum carraway-leaved lomatium Y

Apiaceae Lomatium marginatum Hartweg's lomatium Y

Apiaceae Sanicula bipinnata poison sanicle Y

Apiaceae Sanicula bipinnatifida purple sanicle Y

Apiaceae Sanicula crassicaulis Pacific sanicle Y

Asteraceae Achillea millefolium common yarrow Y

Asteraceae Achyrachaena mollis blow-wives Y

Asteraceae Blennosperma nanum yellow carpet Y

Asteraceae Centaurea solstitialis yellow star-thistle N

Asteraceae Centromadia fitchii Fitch's spikeweed Y

Asteraceae Hesperevax caulescens hogwallow starfish Y

Asteraceae Holocarpha virgata narrow tarplant Y

Asteraceae Hypochaeris glabra smooth cat's-ear N

Asteraceae Lasthenia californica subsp. californica California goldfields Y

Asteraceae Lasthenia fremontii Fremont's goldfields Y

Asteraceae Layia fremontii Fremont's tidy-tips Y

Asteraceae Leontodon saxatilis subsp. longirostris hairy hawkbit N

Asteraceae Matricaria discoidea pineapple weed Y

Asteraceae Micropus californicus Q-tips Y

Asteraceae Microseris douglasii Douglas' microseris Y

Asteraceae Psilocarphus brevissimus woolly marbles Y

Asteraceae Senecio vulgaris common groundsel N

Asteraceae Soliva sessilis South American soliva N

Boraginaceae Amsinckia intermedia common fiddleneck Y

Boraginaceae Plagiobothrys greenei Greene's spiny-nut popcornflower Y

Boraginaceae Plagiobothrys stipitatus Great Valley popcornflower Y

Brassicaceae Thysanocarpus curvipes fringepod Y

Campanulaceae Downingia bicornuta var. picta mountain bristled downingia Y

Campanulaceae Downingia concolor spotted throat downingia Y

Campanulaceae Downingia cuspidata toothed downingia Y

Campanulaceae Downingia pusilla dwarf downingia Y

Caryophyllaceae Minuartia californica California sandwort Y

Caryophyllaceae Cerastium glomeratum sticky mouse-ear chickweed N

Caryophyllaceae Stellaria media common chickweed N

Crassulaceae Crassula aquatica water pygmy weed Y

Cyperaceae Eleocharis macrostachya common spikerush Y

Elatinaceae Elatine californica California waterwort Y

Euphorbiaceae Euphorbia ocellata contura creek spurge Y

Euphorbiaceae Croton setiger doveweed Y

Fabaceae Acmispon wrangelianus Chilean trefoil Y

Fabaceae Lupinus bicolor miniature lupine Y

Fabaceae Trifolium depauperatum dwarf sack clover Y

Fabaceae Vicia villosa subsp. villosa winter vetch Y

Fagaceae Quercus douglasii blue oak Y

Gentianaceae Centaurium tenuiflorum slender centaury Y

Gentianaceae Cicendia quadrangularis timwort Y

Geraniaceae Erodium botrys long-beaked filaree N

Geraniaceae Erodium cicutarium redstem filaree N

Geraniaceae Geranium molle wild geranium N

Iridaceae Sisyrinchium bellum Western blue-eyed-grass Y



Family  Genus Species Variety or Subspecies Common Name
Native 

(Yes/No)

Isoetaceae Isoetes nuttallii Nuttall's quillwort Y

Isoetaceae Isoetes orcuttii Orcutt's quillwort Y

Juncaceae Juncus bufonius toad rush Y

Juncaceae Juncus bufonius var. occidentalis western toad rush Y

Juncaceae Juncus capitatus dwarf rush N

Juncaceae Juncus kelloggii Kellogg's dwarf rush Y

Juncaginaceae Triglochin scilloides flowering-quillwort Y

Lamiaceae Pogogyne zizyphoroides Sacramento beardstyle Y

Lamiaceae Trichostema lanceolatum vinegar weed Y

Liliaceae Calochortus luteus yellow mariposa Y

Lythraceae Lythrum hyssopifolia hyssop loosestrife N

Malvaceae Sidalcea calycosa vernal pool checkerbloom Y

Marsileaceae Pilularia americana American pillwort Y

Montiaceae Calandrinia menziesii red maids Y

Montiaceae Claytonia perfoliata miner's lettuce Y 

Montiaceae Montia fontana water chickweed Y

Onagraceae Clarkia purpurea purple clarkia Y

Onagraceae Clarkia unguiculata elegant clarkia Y

Onagraceae Epilobium cleistogamum cleistogamous boisduvalia Y

Orobanchaceae Castilleja campestris subsp. campestris yellow owl's clover Y

Orobanchaceae Triphysaria eriantha butter-and-eggs Y

Papaveraceae Eschscholzia californica California poppy Y

Papaveraceae Eschscholzia lobbii frying pans Y

Phrymaceae Diplacus tricolor tricolor monkeyflower Y

Phrymaceae Erythranthe guttata spotted monkeyflower Y

Plantaginaceae Callitriche longipedunculata longstock water-starwort Y

Plantaginaceae Callitriche marginata winged water starwort Y

Plantaginaceae Collinsia heterophylla Chinese houses Y

Plantaginaceae Gratiola ebracteata bractless hedge-hyssop Y

Plantaginaceae Plantago elongata coastal plantain Y

Plantaginaceae Veronica peregrina subsp. xalapensis purslane speedwell Y

Poaceae Aegilops triuncialis barbed goat grass N

Poaceae Aira caryophyllea silver hair grass N

Poaceae Avena barbata slender wild oat N

Poaceae Avena fatua wild oat N

Poaceae Briza maxima large quaking grass N

Poaceae Briza minor small quaking grass N

Poaceae Bromus diandrus ripgut grass N

Poaceae Bromus hordeaceus soft chess N

Poaceae Cynodon dactylon Bermuda grass N

Poaceae Deschampsia danthonioides annual hair grass Y

Poaceae Festuca bromoides brome fescue N

Poaceae Festuca perennis rye grass N

Poaceae Glyceria declinata low manna grass N

Poaceae Hordeum marinum subsp. gussoneanum Mediterranean barley N

Poaceae Hordeum murinum subsp. leporinum hare barley N

Poaceae Melica californica California melic Y

Poaceae Orcuttia viscida Sacramento orcutt grass Y

Poaceae Phalaris lemmonii Lemmon's canary grass Y

Poaceae Poa annua annual blue grass N

Poaceae Polypogon monspeliensis annual beard grass N

Polemoniaceae Navarretia leucocephala white headed navarretia Y

Polemoniaceae Navarretia leucocephala subsp. minima little white navarretia Y

Polemoniaceae Navarretia myersii subsp. myersii pincushion navarretia Y



Family  Genus Species Variety or Subspecies Common Name
Native 

(Yes/No)

Polemoniaceae Navarretia tagetina marigold navarretia Y

Polygonaceae Rumex crispus curly dock N

Primulaceae Primula clevelandii var. gracilis Padre's shooting star Y

Primulaceae Primula hendersonii mosquito bill(s) Y

Ranunculaceae Delphinium hansenii Hansen's larkspur Y

Ranunculaceae Delphinium variegatum royal larkspur Y

Ranunculaceae Ranunculus bonariensis var. trisepalus vernal pool buttercup Y

Ranunculaceae Ranunculus californicus California buttercup Y

Rosaceae Pyrus calleryana Callery pear N

Rubiaceae Galium aparine goose grass Y

Rubiaceae Galium nuttallii San Diego bedstraw Y

Themidaceae Brodiaea coronaria garland brodiaea Y

Themidaceae Brodiaea elegans harvest brodiaea Y

Themidaceae Brodiaea minor small brodiaea Y

Themidaceae Dichelostemma capitatum blue dicks Y

Themidaceae Triteleia hyacinthina white brodiaea Y

Themidaceae Triteleia laxa Ithuriel's spear Y

Violaceae Viola pedunculata johnny-jump-up Y

  



 

Orcuttia viscida field photo 
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1. INTRODUCTION  
This document summarizes the 2014-2017 monitoring results from implementation of the 2018 
Phoenix Field Ecological Reserve Sacramento Orcutt Grass Monitoring Plan (Monitoring Plan). 
The Monitoring Plan is included as Part 1 of this report and includes detailed instructions on 
how to implement the monitoring protocol for Sacramento Orcutt grass (Orcuttia viscida) at the 
California Department of Fish and Wildlife (CDFW) Phoenix Field Ecological Reserve (Reserve). 
The purpose of the Monitoring Plan is to facilitate adaptive management of the populations of 
Sacramento Orcutt grass at the Reserve. Implementation of the Monitoring Plan began in 2014 
as a pilot study, and the work was partially grant funded in 2015. The monitoring is expected to 
continue annually into 2021 or later. This document includes an interpretation of results, an 
assessment of the monitoring project, and management recommendations. The results and 
recommendations in this document are a critical step in the adaptive management process. 

2. SUMMARY OF RESULTS 
This document reports on the result of the following monitoring components: 

1. Spring nested frequency monitoring of plants within the two sections of vernal pools on 
the Reserve that contain Sacramento Orcutt grass; and 

2. Photomonitoring of the Reserve.  

In addition, precipitation information generated using a PRISM climate model is presented, 
residual dry matter calculations from 2015 are presented, and general observations of other rare 
plants on the Reserve are reported.  

2.1. SPRING NESTED FREQUENCY MONITORING 

The Locations of Macroplots A and B are presented in Figure 5 of the Monitoring Plan.  

Sacramento Orcutt grass was present in each monitoring macroplot every year from 2014 to 
2017, with most plants found in the deepest portions of pools (Figures 1 and 2). Invasive waxy 
mannagrass (Glyceria declinata) was not observed at all within Macroplot A from 2014 to 2017, 
but waxy mannagrass was observed within several of the random quadrats that were sampled 
within Macroplot B, particularly in the northeast corner of the macroplot. Native common 
spikerush (Eleocharis macrostachya) was not observed at all within Macroplot A from 2014 to 
2017, but common spikerush does occur extensively in Macroplot B, with a dense concentration 
of common spikerush in the northern part of Macroplot B (Figure 3). Other non-native plants 
were within the monitoring macroplots every year, particularly in uplands near pool margins.  

Sacramento Orcutt grass 

In Macroplot A, the frequency (1m2) of Sacramento Orcutt grass was under 50 percent in 2014 
and was significantly higher in 2015. The frequency (1m2) of Sacramento Orcutt grass was 
significantly lower in 2016 than in 2015, and there was no significant difference between 
frequencies in 2016 and 2017 (90 percent confidence levels) (Figure 4).  

The changes in Sacramento Orcutt grass frequency in Macroplot B were similar to those 
observed in Macroplot A. The frequency (1m2) of Sacramento Orcutt grass was under 40 
percent in 2014, and was significantly higher in 2015. The frequency (1m2) of Sacramento 
Orcutt grass was significantly lower in 2016 than in 2015, and there was no significant 
difference between frequencies in 2016 and 2017 (90 percent confidence levels) (Figure 5). 



 
Figure 1
Number of years that Orcuttia viscida was in a random 1m^2 quadrat within a 9m^2 (3m x 3m) area, 
2015-2017 Phoenix Field Ecological Reserve Macroplot A
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Figure 2: Number of years that Orcuttia viscida was in a random 1m^2 quadrat within a 9m^2 (3m x 3m) area, 2015-2017 3 years

Phoenix Field Ecological Reserve Macroplot B 2 years
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Figure 3: Number of years that Eleocharis macrostachya  was in a random 0.0625m^2 quadrat (0.25m x 0.25m) 3 years

within a 9m^2 (3m x 3m) area, 2015-2017, Phoenix Field Ecological Reserve Macroplot B 2 years
Permanent Markers Vernal Pool Margin 1 year

Macroplot Margin 0 years
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Figure 4: 2014-2017 Results of Frequency Monitoring in Pool A at  

Phoenix Field Ecological Reserve 
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Figure 5: 2014-2017 Results of Frequency Monitoring in Pool B at  
Phoenix Field Ecological Reserve 
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Between 2014 and 2017, 2014 may have been the “worst” year for Sacramento Orcutt grass, 
and 2015 may have been the “best” year, with 2016 and 2017 somewhere in between. 

While there was a significantly higher frequency of Sacramento Orcutt grass in 2015, relative to 
2014 and 2016, the frequency of Sacramento Orcutt grass was otherwise relatively similar from 
2014 to 2017. This result shows that although there may have been large differences in the 
number of Sacramento Orcutt grass plants present on the Reserve in different monitoring years, 
Sacramento Orcutt grass occupied a similar spatial arrangement each year. 

Waxy mannnagrass 

No waxy mannagrass was detected in Macroplot A between 2014 and 2017.  

Low frequencies (1m2) of waxy mannagrass were detected in Macroplot B every year between 
2014 and 2017, with the 90 percent confidence interval for the 1m2 frequency estimates 
exceeding ten percent in both 2015 and 2017 (see Figure 5).  

Common spikerush 

No common spikerush was detected in in Macroplot A between 2014 and 2017, 

The frequency (1m2, 0.25m2, and 0,0625m2) of common spikerush in Macroplot B was not 
significantly different between any of the monitoring years from 2014 and 2017 (90 percent 
confidence interval) (see Figure 5). 

Other non-native species  

The frequency (1m2, 0.25m2, and 0,0625m2) of other non-native plant species in Macroplot A 
appears to have significantly increased from 2015 to 2016, and significantly increased again 
from 2016 to 2017 (90 percent confidence interval) (see Figure 4).  

The frequency (1m2, 0.25m2, and 0,0625m2) of other non-native plant species in Macroplot B 
was not significantly different between any of the monitoring years from 2015 and 2017 (90 
percent confidence interval) (see Figure 5). 

2.2. RESIDUAL DRY MATTER 

On September 22, 2015 the amount of residual dry matter (RDM) in upland areas of the 
Reserve was estimated to be 2,081 ± 351 pounds per acre (90 percent confidence). This 
estimate was conducted by clipping and weighing RDM from 17 random one square foot 
quadrats on the Reserve that were not within vernal pools. 

2.3. ANNUAL PHOTOMONITORING FOR ADAPTIVE MANAGEMENT 

Forty-three monitoring photo positions were used at the Reserve. Monitoring photographs were 
taken whenever frequency data was collected at one of the two macroplots. Monitoring 
photographs were also taken opportunistically during other visits to the Reserve. Some of the 
monitoring photos from 2014-2017 are presented in Figures 6 through 11. Monitoring 
photographs from all 43 monitoring photo positions are on file with CDFW’s Native Plant 
Program.  

  



Figure 6 

Photopoint Ah 2014-2018, view to the south (180) of the northeast corner of Macroplot A   
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June 7, 2017, with Orcuttia viscida in pool January 10, 2018 



Figure 7 
Photopoint Ak 2014-2018, view to center of pool from southeast corner of Macroplot A  
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June 7, 2017, with Orcuttia viscida in pool January 10, 2018 



Figure 8 
Photopoint Be 2014-2018, view to the northwest (310) of the northwest corner of Macroplot B 
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Figure 9 
Photopoint Bf 2014-2018, view to the center of pool from the northeast corner of Macroplot B 
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and Sacramento Orcutt grass (Orcuttia viscida) 
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is generally not found in areas with a high density of 

common spikerush (compare Figures 2 and 3). 
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June 7, 2017, with Orcuttia viscida in pool 



Figure 10 

Photopoint Br 2014-2018, view to the north (10) from the southwest corner of Macroplot B 
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June 10, 2014, with Orcuttia viscida frequency (1m2) between 21 and 36 percent (90 percent confidence) 

May 21, 2015, with Orcuttia viscida frequency (1m2) between 48 and 64 percent (90 percent confidence) 

June 7, 2017, with Orcuttia viscida frequency (1m2) between 35 and 52 percent (90 percent confidence) 



Figure 11 

Photopoint Ca 2016-2018, view to the southeast (135) from the Plot C Monument 
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2.4. PRECIPITATION 

Precipitation information generated using a PRISM climate model is presented in Figure 12 
(PRISM 2017). Sacramento Orcutt grass germinates in the fall after the onset of winter 
precipitation, and peak bloom is in June and July. September to June precipitation is therefore 
assumed to be an important factor for Sacramento Orcutt grass growth and survival. Overall, 
there was a positive trend in growing season precipitation from September 2013 to June 2017 
(see Figure 12).  

2.5. OTHER OBSERVATIONS 

In addition to Sacramento Orcutt grass, the rare pincushion navarretia (Navarretia myersii 
subsp. myersii) (California Rare Plant Rank of 1B.1) was also observed on the Reserve, and a 
photopoint was established to monitor the population. The monument for this photopoint is 
located two meters north-east of a blue oak (Quercus douglasii), at approximately 38°39’17.18” 
and -121°12’56.40”. On May 5, 2016, approximately 200 to 1,000 pincushion navarretia plants 
were visually estimated to occur in small pools near the established photopoint on the Reserve. 
The pool was visited again on April 12, 2017, and monitoring photographs were taken; however, 
the pool was still inundated and pincushion navarretia was not yet evident.  

On January 10, 2018 CDFW staff from the North Central Region, with help from CDFW 
volunteers and the CDFW Native Plant Program removed vegetation that was growing along the 
north fence and a portion of the east fence of the Reserve for fire control purposes, and to 
remove non-native trees and vegetation. CDFW’s North Central Region is responsible for 
management of the Reserve. Vegetation was cleared using chainsaws and hand loppers, and 
the vegetation was dragged to the empty, privately-owned lot near the access gate where it was 
chipped, and left on the lot with permission from the landowner. A medium-sized Callery pear 
(Pyrus calleryana) was removed from just inside the access gate, in addition to many small- to 
medium-sized interior live oaks (Quercus wislizeni var. wislizeni), and other woody, non-native, 
ornamental plants. One small interior live oak tree (approximately 8 feet in height) was cut down 
near the boundary of the pool supporting Sacramento Orcutt grass within Macroplot B to 
eliminate impacts to the pool from excessive shading in the future, were the tree to grow larger.  

3. INTERPRETATION OF RESULTS 
With only four years of monitoring data, it is difficult to make strong conclusions; however, 
because growth and reproduction of a considerable number of Sacramento Orcutt grass plants 
occurred within monitoring macroplots every year of monitoring from 2014-2017, and there are 
records of Sacramento Orcutt grass observations at the Reserve for several decades, the 
Sacramento Orcutt grass population at the Reserve appears to be relatively stable at this time.  

Waxy mannagrass was not detected within Macroplot A from 2014 to 2017, but was detected 
within Macroplot B at relatively low frequencies every year during this same period. The 
Sacramento Orcutt grass pools in Macroplots A and B were highly invaded with waxy 
mannagrass in the past (see Photo 25 in Gerlach 2012), but efforts by Dr. Gerlach to remove 
waxy mannagrass in 2007 and subsequent years have greatly reduced the amount of waxy 
mannagrass within these pools. The population of waxy mannagrass within the macroplots on 
the Reserve does not appear to be expanding rapidly at this time, but the conditions that would 
allow waxy mannagrass populations to expand rapidly are not known, and could occur again in 
the future. Despite the low frequencies of waxy mannagrass within macroplots from 2014-2017, 
without management, the possibility continues to exist that the waxy mannagrass population will  



Figure 12 
Estimates of Rainfall at Phoenix Field Ecological Reserve, September 2013 – January 2018 
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expand within Sacramento Orcutt grass pools on the Reserve, negatively affecting Sacramento 
Orcutt grass.  

A dense patch of common spikerush occupies a large portion of the north part of Macroplot B 
and appears to occupy a somewhat different niche than Sacramento Orcutt grass (see Figure 
10). While the two species can occur in the same area, there is some spatial differentiation in 
where the two species occur in Macroplot B (see Figures 2 and 3). If the patch of common 
spikerush were expanding, it could pose a threat to the Sacramento Orcutt grass in Macroplot 
B. Based on the frequency data collected from 2014-2017, the patch of common spikerush does 
not appear to be significantly shrinking or expanding at this time.  

The increase in frequency of non-native plants in Macroplot A from 2015 to 2017 may be due to 
increased rainfall in 2017; however, field notes indicate that some species were incorrectly 
considered to be non-native in 2017, and therefore the frequency estimates from 2017 likely 
overestimate the actual frequencies of non-native plants in 2017.  

Based on the frequency data collected so far, 2015 appears to have been the “best” year for 
Sacramento Orcutt grass on the Reserve. The rainfall for the 2014-2015 growing season was 
unique from the other growing seasons of the monitoring period because December 2014 
rainfall was very high (over 9 inches, which is more than double the rainfall during this same 
month in other growing seasons). Furthermore, December 2014 rainfall was followed by very 
little rainfall in the following months (approximately 5.7 inches of total rainfall in the months of 
January-June 2015, which is less than half of the rainfall in this same time period for other 
monitoring years). Although this anecdotal observation is only based on one year, Sacramento 
Orcutt grass may occur over a greater area within pools in years with early rainfall, followed by a 
period of relatively low rainfall.  

Monitoring photographs taken during frequency estimation (in May or June) are generally 
similar, even in years with significantly different frequencies of Sacramento Orcutt grass (see 
Figure 10).  

Residual dry matter on the Reserve is relatively high and contributes to the accumulation of 
thatch in upland areas, but because Sacramento Orcutt grass only occurs in areas that are 
largely unaffected by thatch, this thatch is unlikely to directly impact Sacramento Orcutt grass.  

4. ASSESSMENT OF THE MONITORING PROJECT 
The monitoring project has been largely successful. Our methods resulted in basic baseline 
photomonitoring and frequency data that can easily be collected again in the future. 
Furthermore, simply by visiting the Reserve to collect frequency data, we are better able to 
identify the areas that are at highest risk from the spread of waxy mannagrass, and target those 
areas for waxy mannagrass eradication efforts. The monitoring is also relatively time-efficient. It 
is possible for the monitoring data to be collected in only one day if at least two field workers 
familiar with the methods get an early start, and avoid overexertion in the summer heat.  

Monitoring photos taken during frequency estimation in 2016 were taken using an incorrect 
camera setting and were severely underexposed. The image quality of those photos is therefore 
very low, and they were not included in this report. Additionally, attempts to precisely align 
monitoring photos has been difficult. Precise alignment of monitoring photos is important 
because it allows direct comparison of specific areas of the ground in the photograph, and it 
may be very difficult to determine which areas of the ground are the same if two monitoring 
photos are even slightly misaligned. Differences in perspective resulting from photographs taken 
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with different cameras, from slightly different positions and in slightly different directions can be 
very distracting, and may require careful correction with photo editing software such as Adobe 
Photoshop before insightful comparisons become possible. Because correcting the differences 
in perspective requires photo editing expertise and a considerable time commitment, every 
effort should be made to standardize monitoring photos as much as possible in the field. A 
workflow for correcting images in Photoshop has been included with this report as Appendix A.  

5. MANAGEMENT RECOMMENDATIONS 
The management objective and management implication identified in the Monitoring Plan are 
repeated below, with a discussion of whether the management implication should be triggered 
based on the monitoring results.  

5.1. MANAGEMENT OBJECTIVE #1 

Maintain a frequency of 10 percent or less (1 m2 quadrat) of waxy mannagrass (Glyceria 
declinata) in Macroplot A and Macroplot B at Phoenix Field Ecological Reserve in every year. 
(This is a target/threshold type of management objective.)  

Management Implication from Monitoring Plan: If any portion of the 90 percent confidence 
interval for waxy mannagrass frequency (1 m2) exceeds 10 percent in Macroplot A or Macroplot 
B, CDFW shall organize and initiate a waxy mannagrass hand pulling effort in the following 
year, before waxy mannagrass seeds have set. 

Recommendation: The 90 percent confidence interval for waxy mannagrass exceeded ten 
percent in both 2015 and 2017, therefore the management implication should be triggered in 
2018. Targeting the general locations where waxy mannagrass was identified in Macroplot B 
between 2014 and 2017, CDFW staff should use clean rubber boots to wade into pools and cut 
each waxy mannagrass plant above the root system to remove the upper portion of the plant, 
effectively killing it. This method was used by Dr. John Gerlach to effectively control waxy 
mannagrass on the Reserve in 2006 and subsequent years. CDFW staff will visit the Reserve in 
early April to check the phenology of waxy mannagrass, and initiate the control effort shortly 
thereafter, prior to seed dispersal.  

5.2. OTHER RECOMMENDATIONS 

If time allows, CDFW should more closely monitor the small pincushion navarretia population on 
the Reserve and visit the Reserve it at the appropriate time of year to monitor both the 
pincushion navarretia and Sacramento Orcutt grass populations at the same time, perhaps in 
late May to early June.  
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Workflow for Aligning Monitoring Photos in Photoshop 

This procedure provides a rough outline of a technique for aligning monitoring photos taken from the 

same location using Photoshop CS6. 

1. Open Photoshop CS6 

2. Under “File”, select “Scripts” > “Load Files into Stack” 

3. Select “Browse” and select all monitoring photos you would like to align 

a. Only check “Attempt to Automatically Align Source Images” if there are lots of 

buildings or other visually distinct aspects to the image, and even then, this may not 

work well. If the result does not look good, start over and uncheck this box. 

4. Select “Image”, and “Canvas Size” and increase the vertical and horizontal canvas size by a few 

inches. 

5. Select the top layer in the layers window, select “Filter” and “Lens Correction…” For “Edge” 

select “Edge Extension”. Select OK.  

a. NOTE: For photos taken with an SLR camera (Nikon d3100/d3300) a lens profile is 

available, and should be used. The Native Plant Program point and shoot Sony camera 

does not have a lens profile, so skip the lens correction step for photos taken on the 

Sony.  

6. Use the eye button to make the top layer that was just corrected invisible, click on the next 

layer down to select it, and repeat Step 5 for all remaining monitoring photos.  

7. Make the top layer visible again and click it to select it in the layers window. Click and hold the 

eyedropper icon in the tools window, and select the ruler tool in the submenu. 

8. Click and hold on a specific feature on the horizon on the left side of the image, and drag a ruler 

line to a specific feature on the horizon on the right side of the image. Click the “Straighten 

Layer” button at the top of the window. Repeat steps 6 and 7 for the remaining layers so that 

the horizon is straightened in the same way for all monitoring photos. 

9. Select a reference photo with lots of landmarks and identifiable features, and move it down to 

the bottom layer in the layers window. (This will be your Reference Photo)  

10. Make all layers invisible in the layers window, except for the bottom two layers. Make the layer 

above the bottom layer about 50 percent transparent by selecting it in the layers window, and 

using the “Opacity” slider, so that you can see features from both images at the same time.  

11. Use the “Move Tool” by pressing V on the keyboard, and dragging the top layer so that it 

matches the bottom layer as best as possible. Getting the horizon to match as much as possible 

is a good first step. Matching features in the foreground is more difficult. There are several 

techniques that can be used to help with this: 

a. Resizing the layer by holding the shift key (to maintain aspect ratio) and clicking and 

dragging a corner of the layer.  -> be sure that “Show Transform Controls” is checked.  

b. “Edit” > “Transform” > “Warp” can be used to drag features to where they need to be. 

If a rock or tree needs to be moved to line up with the same rock or tree underneath, 

simply drag it and move it. You will likely need to go back to other areas of the photo to 

stretch everything into the right place. Just work on the photo until you are happy with 



the result. (Important note: do not accept the changes and apply the transformation by 

pressing the “enter” key until you are completely happy with the result. Every time you 

accept a transformation, the act is destructive, and it permanently degrades the quality 

of the image) 

c. “Edit” > “Transform” > “Perspective” can also be used if a side of the image is skewed in 

one way or the other. Grab the edge you want to move and move it. I have only used 

this successfully a few times, typically if most to the telephone poles are leaning in one 

direction, for instance.  

d. Once you have begun transforming the layer, you cannot turn the layer on and off to 

check your work anymore, and you should therefore use the “Opacity” slider to see 

what is underneath and check your work. 

12. When you have completed a layer, make it invisible with the eye button, and make the next 

layer above visible, select it, and continue with Steps 8, 9 and 10 until you have edited all of the 

layers. 

13. Select “File” > “Save As” and save the photoshop file as the photopoint name in the appropriate 

location on the U Drive, for example: U:\Groups\HCPB\Shared Folders\NPP\Section 

6\2014\Priority Plant Surveys\Project Files\Butte County Limnanthes Files\Stone Ridge\All 

renamed photos here for comparison\Aligned Photos\Aq  

(You might need to make a new Aligned photos folder in renamed photos folder) 

14. Make all layers visible and select all layers. Select “View” > “Show” > “Layer Edges” to give you 

an idea of where all of the layers overlap. Select the Rectangular Marquee Tool from the toolbar 

window (a dashed rectangle).  

15. Draw a selection within the area that all (or most) of the layers overlap. -> The layer edges will 

disappear once you start to draw your rectangle so be sure to get a good idea of where to draw 

before you start. 

16. After the photoshop file has been saved, crop the image down by selecting “Image” > “Crop” 

17. Make only the top layer visible and select it. If there are any areas along the edges where you 

can see the transparency underneath and want to fill it in with camouflage, select the area using 

the magic wand tool from the toolbar. After selecting the transparency, select “Select” > 

“Modify” > “Expand” and increase the selection by 5 pixels. 

18. Next click “Edit” > “Fill…” and select “Content Aware” to fill the blank areas.  

19. Next click “File” > “Save as”, change the file type to JPEG and save the file in the appropriate 

photopoint folder on the U drive, with the filename corresponding with that photopoint and the 

date the photo was taken. 

20. Repeat steps 15, 16 and 17 for the remaining layers.  
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